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  To Create a New Message:
 On the Standard toolbar, click E-mail.
 Enter one or more e-mail addresses in the To: (Cc:) box, or click Address Book 

icon to search the Address Book.
 Enter the subject of the message in the Subject: box.
 Enter the text of your message in the text box.
 Click Send.

  To Attach a File:
 While still in the new message window, select Attach File from the Message 

tab toolbar. Select the file you want to send, and click Choose.

  To Open an Attachment:
 Double-click the attachment at the top of the Reading pane.

  To Save an Attachment:
 Open the e-mail by double-clicking on it. Right-click the attachment and click 

Save As... Select the location where you want to save the attachment and 
click Save. Or drag the attachment to the location to which you would like it 
saved.

  To Create a Folder:
 From the Organize tab on the Ribbon, click New Folder. Name the Folder and 

hit the <Enter> key.

  To Move a Message into a Folder:
 Messages can be dragged from the Inbox and dropped in other Folders.

  To Open a Message:
 Open the Inbox. Click on a message to preview it or double-click to open. 

  To Group/Sort Messages:
 In the Navigation pane, select the Folder to group/sort. In the Folder pane, click 

the Arranged By: title bar and select the arrangement criteria.

  To Check for New Messages:
 Outlook is set to automatically check for new messages. To manually check for 

message, click the Send/Receive button from the Home tab on the Ribbon.

  To Print a Message:
 Click on the message that you would like to print and then click the Print icon 

from the Quick Access toolbar.

  To Delete a Message:
 Select the message and click the Delete icon or press the Delete key on your 

keyboard. This will move the message to the Deleted Items folder. To empty the 
Deleted Items folder, right-click it and then click Empty Folder.

  To Reply/Reply All:
 Click the message to be replied to in the Folder pane and click Reply or  

Reply All, type your reply, and click Send.

  To Forward a Message:
 Click the message to be forwarded, click Forward, enter the e-mail addresses in 

the To: box, type any comments in the text box, and click Send.

  To Send a Blind Carbon Copy (Bcc):
 While still in the new message window, click Options on the Ribbon. Click the 

Bcc button. A new row labeled “BCC” appears under the CC: area. 

  Message Indicators:
 Message has not been read
 File is attached to the message

 Message has high priority
 Message has low priority 
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To show/hide the ribbon, 
click the arrow.



The Ribbon

You CAN’T:
  Add, rearrange, or remove 

commands
  Change or remove groups
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You CAN:
  Minimize the Ribbon
  Customize the Quick 

Access toolbar (click the 
down arrow to the right 
of the toolbar, then select 
More Commands)

Customizing the Ribbon:

In Outlook 2011 the ribbon shows 
tools for all tasks.
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  To Save a Message as a Draft:
 While still in the new message window, click Save on the Quick Access toolbar. 

The message appears in the Drafts folder.

  To Resend a Message:
 Select the message in the Sent Items folder. From the Message menu, select 

Resend. The message will open in a new window. Type in the recipient’s e-
mail address, then click Send.

  To Change Message Options:
 While composing a message, click the Options tab on the Ribbon. Here, you 

can specify:
o Permissions
o Security

o Format
o Background

  To Create a Signature:
 When composing a message click the Signature button. Click Edit Signatures... 

Click the + to create a new signature. Name the Signature and then type the 
text that you would like for your signature and then close the window. To 
insert your signature select it from the Signature button drop-down menu.

 To use a different signature select a different signature from the Signature 
button drop-down menu.

  Flag a Message as a To-Do Item:
 Select the message in the Folder pane, click the Follow Up button on the  

Standard toolbar, and select a flag. 

  To Clear a Flagged Message:
 Select the message in the Folder pane, click the Follow Up button on the  

Standard toolbar, and select Clear Flag.

  To Search a Folder:
 With the folder selected that you would like to search, type in your search 

terms into the search box labeled Search This Folder, then hit the <Enter> key.

  To Create a Contact Group:
 On the Standard toolbar click on the New drop-down menu and then select 

Contact Group. To add contacts click the Add button and type in the informa-
tion for the person that you would like to add. You can also double-click in an 
empty space to create a new entry. If you are content with this contact group 
click Save & Close.

  To Send to a Contact Group:
 While composing a message, click the Address Book icon. Search for the name 

of the group and then click To, Cc, or Bcc to send an e-mail to the group that 
has been selected.

  To Edit a Contact Group:
 Click on the Contacts Search button from the Standard toolbar. Search for the 

desired group and double-click the group. Use Add and Remove to edit the 
group. Click Save & Close from when done. 

  To Categorize a Message by Color:
 With the message selected in the Folder pane click the Categorize button from 

Standard toolbar, and select a Color category.

  To Rename the Color Category:
 Click Categorize on the Standard toolbar, and select Edit Categories... Double-

click the name of the category to be changed and rename it what you would 
like it named.

Creating a Vacation Message Spam controls
  Creating a Vacation Message:

 From the Tools tab in the Ribbon click Out of Office.

 To turn ON: select Send Out of Office messages.
o Auto-replies begin immediately unless you specify Start / End dates.
o Type the message to be sent in the Reply to messages with: box.
o The Reply to each sender outside of my company with: box: This message 

is optional. If you would like to send it, create the message AND

• Activate by clicking the Send replies outside of 
my company to: checkbox.

• Select recipients: Address book Contacts only or 
Anyone outside my company.

 To turn OFF: select Do not send Out of Office messages.

  Controlling SPAM:
 In order to reduce the number of false positives, ETS recommends that you 

allow the E-mail server to filter your e-mail instead of using the spam filters 
available on individual mail clients.

 To do this, you must turn off the spam filters in your mail client which are set 
to “On” by default.
o From the Junk drop-down menu in the Ribbon, select Junk E-mail 

Protection...
o In the Junk E-mail Options window that comes up, click to select None, 

Turn junk e-mail protection off. Then, click Okay to save your choices.
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Date Navigator

To view the Calendar 
click the Calendar 
button.

My Calendars List

Status Bar

Calendar pane
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  To Create an Appointment:

 Click on the Appointment button or double-click anywhere in the Calendar to 
get a new Appointment window. (shown to the right)

o Enter a Subject and Location for the Appointment.
o Select Start and End times.
o Add related information in the text box.
o Click Save & Close in the Actions group on the Ribbon.

  To Delete an Appointment:
 Click the Appointment in the Calendar pane, then click Delete on the Standard 

toolbar.

  To Color Code an Appointment:
 Click the Appointment in the Calendar pane, click Categorize in the Standard 

toolbar, and select a category.

  To Change the Length of an Appointment:
 Double-click the Appointment and change the Start or End time.

  To Change Date/Time of an Appointment:
 Click on any part of the Appointment in the Calendar pane. Hold down the left 

mouse button and drag the Appointment to the desired date/time. Or, double-
click the Appointment, and change the Start and End dates/times.

  To Create a New Calendar:
 From the Organize tab in the Ribbon click New Calendar... Give the new  

Calendar a name such as Personal, Resource, Seminars, etc and hit the  
<Enter> key. The new Calendar appears in your My Calendars list in the  
Navigation pane.

  To View Different Dates:
 Click on the desired date in the Date Navigator. The new dates appear in the 

Calendar pane.

  To Go to Today:
 In the Standard toolbar click Today.

  To Change Dates Displayed in Date Navigator:
 Click the arrows to either side of the month at the top of the Date Navigator.

  To Change Views:
 Click Day, Week, or Month located on the Standard toolbar for different views 

of your Calendar.

  View Multiple Calendars:
 Click on the checkbox next to the calendars you would like to view in your  

My Calendars list. The Calendars will appear side by side in the Calendar pane.
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The Calendar Ribbon

In the Appointment and Meeting 
windows, the Ribbon will show 
Meeting related actions.
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Meeting/Appointment Windows

  Create a Meeting Request:
 Click the Meeting button from the Standard toolbar, or click the Appointment 

button and then click on Invite.
o Set up: Fill in the Subject, Location, Date, and Time.
o Invite Guests: Click the Address Book icon and search for the contacts 

Guests you would like to invite, or type the e-mail in the To: field. Click 
Required or Optional to add the selected names to that group. Close the 
contact search window when finished.

o Additional Information: If desired, add additional information by typing in 
the text box or attaching files, business cards, tables, or illustrations from 
the Insert tab.

o Request an RSVP: If desired, on the Request Response icon located to the 
right of the Recurrence icon.

o Send: Click Send to send the invitation to the Invitees.

  To View Invitee Schedules:
 To find times when everyone is available, add Invitees to the Meeting as  

described above. Click Scheduling Assistant tab on the bottom of the  
Appointment window.
o Use the scroll bar under the Attendee list to view different dates.
o An Attendee’s row will be blocked when they are NOT available.
o Adjust Start/End times at the bottom of the Scheduling window.
o When finished, click Message tab to return to the Meeting details and the 

message to be sent.

  To Add/Delete Guests:
 Double-click the Meeting to open it. Click Scheduling Assistant as described 

above. Invite additional guests as described above. Remove guests by deleting 
them by clicking on the name in the To: field and hitting the <Delete> key.

  To Reschedule or Update a Meeting:
 Double-click the Meeting, make your changes, then click Send Update.

  To Cancel a Meeting:
 Open the meeting by double-clicking it. Click Cancel Meeting, then click  

Send Cancellation.

  To Respond to a Meeting Request:
 Meeting Requests arrive in the Mail Inbox. Double-click the Meeting Request 

to open it. Click on one of the Responses located at the top of the request and 
select how to respond.

  To Track Response:
 Responses wil be sent to your e-mail once people have selected whether or not 

to attend .

  To Create a Tentative Meeting:
 Create a meeting as usual. Before sending, click the Status box and select 

Tentative. Complete and Send the Meeting Request. The Meeting will appear 
with a striped border in the Attendees’ calendars until the Tentative option is 
removed.

  To Create Recurring Meetings:
 While creating a Meeting, click Recurrence. Select how often you would like 

for the meeting to reoccur or select Custom... to create a unique schedule. 
Complete and Send the Meeting Request.

  To Share Your Calendar:
 Right-click on the calendar you would like to share and selct the  

Share Permissions option. 

o When this new window opens select Add User...
o Search for the person, select their name and click OK.
o Click OK again to share your Calendar.

  To View Shared Calendars:
 Once granted permission to see a Shared Calendar, that Calendar will appear 

in your My Calendars List in the Navigation pane. Click on the Shared Calendar 
to view it.

Contacts tasks
  To View Your Contacts:

 In the Navigation pane click Contacts.

  To Create a New Contact:
 From the New menu select Contact, or from within the Contact section click 

Contact.

  To Edit a Contact:
 Double-click the contact.

  To Find a Contact:
 Type the contact to search for in the Find a Contact box.

  To Delete a Contact:
 Select the contact and press the <Delete> key.

  To View a Task:
 Your Tasks for each day appear in the Task section, found in the Navigation 

pane. Double-click the task to view the details.

  To Work with Tasks:
 Click Tasks in the Navigation pane to enter Task View.

  To Create a New Task:
 From the New menu select Task, or from within the Task section click Task.

  To Complete a Task:
 In Simple List view, check the task’s check box.

  To Delete a Task:
 Select the task and press the <Delete> key.

  To Create a Recurring Task:
 Double-click the task and click Recurrence, then define how often the task will 

reoccur.


